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Preface

This User’s Guide is intended to provide detailed information on the functionality of the model
and acts as an extension and elaboration of the on-line help. The section on References provides
an extensive listing of documents that may be of further assistance to the user in the use of EDMS
and the preparation of an Environmental Impact Statement (EIS).

This user manual provides instructions for installing and using EDMS version 5.0. The manual
describes how to enter data, how to obtain various forms of output, and includes an example that
exercises many commonly-used features of the software. The chapters are organized in the
following manner:

o Chapter 1 provides a brief history of the evolution of EDMS, instructions for installing
the software, a note to users of EDMS from outside of the United States, a high level
overview of the model architecture, and a summary of the features and limitations of
EDMS.

o Chapter 2 gives a summary of the types of data accepted by EDMS for generating an
emissions inventory.

o Chapter 3 gives information about weather data and the airport layout..

o Chapter 4 is similar to chapter 2 and provides a description of the data used to estimate
concentrations.

e Chapter 5 describes the functionality offered by the EDMS utilities, including:
operational profiles, user-created aircraft, ground support equipment and auxiliary power
units.

o Chapter 6 in contrast to the previous chapters gives specific step-by-step instructions for
interacting with each of the EDMS screens. It is anticipated that most users will read
chapters 2 through 5 to familiarize themselves with EDMS and then will use chapter 6 as
a reference when working with the model.

e Appendix A contains an example study to allow new users to learn the basics of
performing an emissions and dispersion analysis with EDMS. The example uses
fictitious data and should not be the basis for any regulatory action.

o Appendix B describes that import and export formats used by EDMS 5.0. Advanced
users can use the import and export utility to bypass most of the EDMS user interface.

e Appendix C provides photographs of the GSE Reference Models used in EDMS 5.0 to
allow for a more accurate selection of GSE for a study.

As a companion to this user manual, the EDMS Technical Manual provides detailed descriptions
of the algorithms and data used by EDMS 5.0. In addition, the answers to Frequently Asked
Questions and contact information for receiving additional support are posted to the EDMS web
site. A link to the EDMS web site can be found at
www.faa.gov/about/office_org/headquarters_offices/aep/models/.
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1 BACKGROUND INFORMATION

1.1 History

EDMS is a combined emissions and dispersion model for assessing air quality at civilian airports
and military air bases. The model was developed by the Federal Aviation Administration (FAA)
in cooperation with the United States Air Force (USAF). The model is used to produce an
inventory of emissions generated by sources on and around the airport or air base, and to
calculate pollutant concentrations in these environments. A timeline of development history of
EDMS is given in Figure 1-1.

Figure 1-1: EDMS History.

EDMS History
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Complex Source Microcomputer Model ]
Introduced Aircraft PM (FOA 2.0)

EDMS 5.0

Current Version

In the early 1970s, the FAA and the USAF recognized the need to analyze and document air
quality conditions at and around airports and air bases. Each agency independently developed
computer programs to address this need. The USAF developed the Air Quality Assessment Model
and the FAA developed the Airport Vicinity Air Pollution Model (AVAP). These models were
used to perform limited air quality assessments in the late 1970s. Recognizing the inefficiency of
maintaining two non-EPA approved models, the agencies agreed to cooperate in developing a
single system that would have regulatory, operational and economic benefits. The result was the
EDMS development effort jointly supported by both agencies and leading to a model listed
among the EPA’s preferred guideline models.

Emissions modeling in the FAA began with the early Simplex A modeling efforts using the HP-
97 calculator. The Simplex A algorithms included calculations for aircraft takeoff plume
dispersion. In the 1980s, the model was moved to the Apple 1l computer and the Simplex A
algorithm was expanded to include dispersion calculations for roadways, parking lots, and power
plant sources. The revised and enhanced Simplex A model became known as the Graphical Input
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Microcomputer Model (GIMM). GIMM was ported to a PC and further enhanced by
improvements in processing speed and refinement of the emissions inventory calculations. This
enhanced version of GIMM became known as EDMS. In 1997 EDMS was reengineered for
Microsoft® Windows™ and included the algorithms from the Environmental Protection Agency
(EPA) dispersion models PAL2 and CALINE3. With the release of version 3.0 in 1997, EDMS
became the FAA-preferred model for air quality assessment at the airport and air bases. In 2001
EDMS 4.0 was released which marked the transition to EPA’s next generation dispersion model
AERMOD as the main dispersion engine behind EDMS, and the introduction of aircraft
performance data to allow EDMS to estimate the contribution to concentrations from aircraft up
to 1,000 feet above the ground.

In 2004, the FAA re-engineered EDMS once again to take advantage of new data & algorithm
developments and released the software as EDMS Version 4.2. This version of EDMS allowed
users to select the version of EPA’s MOBILE model (5a, 5b, or 6.2) to use for on-road vehicle
emissions estimation. An interface to EPA’s AERMAP terrain processing module was also
provided for the first time in this release. AERMOD version 02222 was bundled with the EDMS
software and was the most current version of AERMOD available as of September 30, 2004.
Incremental releases of EDMS 4.3 in 2005, EDMS 4.4 in 2006, and EDMS 4.5 also in 2006
provided updates to the system data, and updates of EPA models. In particular, EDMS 4.4
contained an upgrade of AERMOD and AERMET to version 04300, which was the first version
of AERMOD promulgated by the EPA.

Also in 2004, the FAA embarked on development of its next generation of airport analysis tools,
known as the Aviation Environmental Design Tool (AEDT). The development of this toolset is a
6-year effort that will result in the ability to model noise and emissions interdependencies. AEDT
is being developed in phases and leverages the investment made in EDMS and the Integrated
Noise Model (INM). Today, the first phase of development is complete, which represents a 2
year effort, and harmonizes the underlying system data from both of those models as well as the
aircraft performance calculation methods.

EDMS 5.0 has been given a new architecture and includes over 150,000 new lines of code to
support additional enhancements to its capabilities and the evolution toward AEDT. A study can
now contain multiple scenarios, multiple airports and span multiple years, with emissions or
dispersion being run for all at once. The First Order Approximation version 3.0 has been
incorporated for estimating PM emissions from jet aircraft. Aircraft fleet data have been
harmonized with INM, and a common dynamic flight performance module exists in both tools as
well, that accounts for aircraft weight and meteorological conditions. EDMS 5.0 represents the
state of the art for airport emissions modeling and an important step toward the development of
AEDT.

1.2 EDMS Requirements and Installation Procedures

1.21 Hardware Requirements
The EDMS software runs on a PC with the following minimum hardware requirements:

Intel Pentium 4 processor or compatible operating at 1.3 GHz or greater
512 MB RAM (1 GB recommended for dispersion analyses)

2 GB free disk space minimum, 10 GB free disk space recommended
CD-ROM drive

Mouse or other pointing device
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1.2.2 Operating System Requirements

The EDMS software is a 32-bit Windows™ native application, compatible with the following
operating systems:

e Microsoft® Windows™ 2000 or XP

1.2.3 Installation Procedures

The EDMS software, data files, and example studies are provided on CD-ROM. To install the
EDMS software and components:

e Insert the EDMS CD into your CD-ROM drive.
¢ Run the program Setup.exe on the CD.

The EDMS setup program will then guide you through the installation process. You will have the
option of installing the EDMS 5.0 software files complete with bitmaps, sounds and fonts or
installing the software files only. A complete installation (software, bitmaps, sounds and fonts)
requires about 700 megabytes of hard drive space. The typical installation (software alone)
requires about 60 megabytes of hard drive space. When the installation setup is complete, an
EDMS folder will be created with icons to launch the model, the on-line help and the un-installer
program for removing EDMS from the system.

1.24 A Note for EDMS Users Outside of the United States of America
In order to run dispersion, surface weather data is required in one of the following formats:

TD-3280
TD-3505
CD-144
HUSWO
SCRAM
SAMSON

Surface weather data must be converted to one of those formats to be used in EDMS.

In addition, an early morning upper-air sounding is required in either TD-6201 or FSL format.
Typically, these soundings occur at 00:00 GMT and 12:00 GMT, which does not provide a
sounding at the necessary time for much of the globe. If an appropriate sounding is not available
for your location, the Lakes Environmental Upper Air Estimator (available from
www.weblakes.com) may be appropriate. Specific guidance regarding the AERMET data
requirements are provided in the AERMET User’s Guide, available from
www.epa.gov/scram001/7thconf/aermod/aermetugb.pdf.

1.3 System Architecture

1.31 Components and Modules
In offering functionality for performing both an emissions inventory and dispersion modeling,
EDMS consists of several layers of interaction as depicted in Figure 2-1. This figure is a high
level representation of the interaction between different components within the framework of a
single integrated environment.

The back-end for both the emissions inventory and dispersion modeling is the database
comprising tables for system data and user-created sources. The front-end is the graphical user
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interface (GUI). The user interacts with the model and the database through the GUI. At the GUI
level, the user performs data entry (with parameter validation), executes commands, and receives
visual feedback of both data entered and results generated. The middle portion between the GUI
and the data tables is the core of the EDMS application, and contains the set of classes and
functions that represent each emissions source and dispersion object and its associated properties.
This middle layer allows for study and system data to be retrieved from disc and stored in
memory while the study is open to enable the user to make changes without those changes
immediately altering the original study on disc.

This architecture is typical of current-day multi-tiered applications and allows for modularity of
components by separating the database-related functions from the core business logic from the
graphical user interface. Providing modularity will prove to be an important benefit as EDMS
continues its transition into the AEDT environment in the future.

External interfaces to EDMS are shown with a dashed border in Figure 1-2. These programs
include: AERMAP (v.06341), AERMET (v.06341), AERMOD (v.07026), and MOBILE (v.6.2),
all of which are maintained by the EPA. For all of these programs, inputs are collected through
the GUI, passed to the business layer, and sent to the external program for processing. Once the
run is complete, the results and associated messages are interpreted by EDMS and displayed to
the user.

Figure 1-2: EDMS System Architecture.

Graphical User Interface

EDMS
Sources
(Aircraft, Dispersion Reporting

Roadways, Module Module
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In addition, EDMS contains an Aircraft Performance Module and Aircraft Emissions Module that
are common to components in AEDT.

The emissions processor uses a combination of EPA models and best available models from other
sources such as CAEP for calculating aircraft emissions, on-road and off-road vehicles emissions,
and stationary source emissions. On-road vehicle emissions are calculated by the version of
EPA’s MOBILE model selected. The dispersion-modeling module generates input for the EPA-
developed dispersion model, AERMOD. EDMS offers the flexibility of allowing the user to
perform an emissions inventory only or in additional also perform dispersion modeling.

The view modules permit the user to view output, receptor concentrations and system data stored
in the database. They also allow the user to view a graphical representation of the various sources
in the database. EDMS contains a reporting component for generating emissions inventory results
formatted for the printer. Dispersion results and reports are generated by AERMOD.

In addition, the model incorporates utilities for importing and exporting some types of data, and
allows the user to add customized aircraft types and ground support equipment to the system
database. A detailed description of the algorithms and data used by EDMS can be found in the
EDMS Technical Manual.

1.3.2 EDMS Modeling Options

EDMS performs two primary functions: generating emissions inventories and performing
dispersion analyses. Performing a dispersion analysis requires first generating the emissions
inventory for the same set of user inputs.

1.3.2.1 Enabling Dispersion

The first option is whether to enable dispersion. Enabling dispersion forces the selection of
several other options in order to provide greater precision and greatly increases the amount of
time needed to generate the emissions inventory, and thus should not be selected unless needed.

1.3.2.2 Aircraft Times in Mode Basis

“Times in mode” refers to the amount of time an aircraft spends in different portions of a landing-
takeoff cycle (LTO). In EDMS an LTO cycle is divided into six phases: approach, taxi in, gate,
taxi out, takeoff and climb out. The airborne modes consist of the following portions of the LTO
cycle: approach, takeoff and climb out. The landing roll portion of the approach segment is
incorporated into the taxi in time. There are two options for determining the times in mode for the
aircraft being modeled: Performance Based and ICAO/USEPA Default. Performance based
modeling uses the specific airframe and engine characteristics along with weather data to model
each flight dynamically. ICAO/USEPA defaults are standardized values read from a table.

Performance based modeling is required when dispersion is enabled.

1.3.2.3 Aircraft Taxi Time Modeling

The two options for determining taxi times are User-specified taxi times for each aircraft and
Delay and Sequence Modeling. For user-specified taxi times, the user can define defaults for taxi
in and taxi out times that apply to each aircraft added to the study. These taxi times can then be
changed for each aircraft if necessary. Delay and Sequence modeling takes into account the
aircraft operational schedule demands, active runway configurations, and delays associated with
airport capacity to model the ground movement of the aircraft and determine specific taxi times
for each aircraft operation.

Sequence modeling is required when dispersion is enabled.
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1.3.2.4 Aircraft Schedule Options

If the user has a schedule file, which contains the scheduled pushback and landing times for every
aircraft, it can be used by EDMS as the basis for sequence modeling, and also to determine the
number of operations for each aircraft type. If no schedule file is available, EDMS can generate a
“pseudo-schedule” from the annual operations and operational profiles, and use that as the basis
for sequence modeling when that is selected.

1.3.2.5 Weather

The options for weather are Use Annual Averages and Use Hourly Meteorological Data.
Regardless of that choice, the user can also set the mixing height to anything from 1,000 to
10,000 feet. The mixing height provides a vertical cutoff for EDMS’s modeling of aircraft
emissions. Hourly meteorological data must be processed through AERMET.

Hourly weather data is required for dispersion.

1.3.3 Structure of an EDMS Study

There are three independent aspects of an EDMS study: the scenarios, the airports and the years.
Each study must have at least one scenario, one airport and one year defined. These are arranged
in a hierarchical manner to facilitate the design, programming and maintenance of EDMS. Within
the study the scenarios are given the highest rank, followed by the airports and finally the years.

As shown in Figure 1-3, in the left pane of the study window is a tree showing the structure of the
study. By clicking on a name or the preceding icon, the user can select what is currently active:
the whole study, a particular scenario, a scenario-airport combination, or a scenario-airport-year
combination. Selecting a lower-level item implicitly means that the higher-level items to which it
pertains are also selected. For example, selecting a particular year would give access to the items
associated to the airport, scenario and study above it in the tree, as well as all application level
functionality. Right-clicking on a name will bring up a menu with some options germane to that
item.
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Figure 1-3: Main Window, Study Tree.
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1.3.3.1 Application Level

User-created Aircraft, User-created GSE and User-created APUS are defined at the application
level, that is, they can be created without having a study open, and once defined they are available
to any study created under that installation of EDMS. This essentially permits the user to add
custom extensions to the corresponding system tables.

1.3.3.2 Study Level

When the whole study is selected, then the user has access to features and data that apply to the
whole study. Accessible features include the options under the File menu, Update Emissions
Inventory under the Emissions menu, Run AERMOD under the Dispersion menu, all options
under the View menu except the Airport option, all options under the Utilities menu except
Operational Profiles, the Window menu and Help menu. Update Emissions Inventory and Run
AERMOD are run for all scenarios-airport-year combinations where the data have changed since
they were last run. Study properties are stored at this level.
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1.3.3.3 Scenario Level

This level consists mainly of settings for modeling options such as the choices for the times in
mode and taxi times. Users can create several scenarios, representing different modeling options
for comparison.

There is no data at this level except the scenario properties, which were already accessible via the
Study Properties > Scenarios = Scenario Properties dialog chain at the study level, and hence
the available options are the same as on the Study Level. The right-click menu for the scenario
name in the study tree provides another path to the same functionality. The scenario and airport
are largely independent of each other within the study and only when both are selected does more
functionality become available.

1.3.3.4 Airport Level

Only information entered on the Airport Properties dialog is tied to the particular airport, and
applies across all scenarios for that airport in the study. All other data at this level are associated
with the scenario and airport combination. The items that can be defined at this level include
weather, gates, taxiways, runways, taxipaths, runway configurations, and the emissions sources
that are included. The operational information for each source is not associated with this level,
since it can change from year to year. All airport layout definitions such as runways apply to only
the specific scenario and airport combination. To model variations in airport layout, the user can
create multiple scenarios with one airport, or have multiple instances of the same airport under a
single scenario, with a separate layout for each scenario-airport combination.

At the airport level more menu options are available; however there are instances where some
portion of a dialog is disabled, because the information is specific to a particular year, primarily
operational usage data. The menu items accessible at this level include the Airport menu, the
Airport option under the View menu, and the Operational Profiles option of the Utilities menu.

1.3.3.5 Year Level

This level is the lowest and most detailed level, and contains information that varies for each
year. Operational usage data (such as number of operations and the duration of each operation)
for emissions sources is associated with this level, so it can only be entered when a particular year
is selected. At the year level there are no restrictions on menus or dialog due to the selected level.

134 Working with an EDMS Study

When setting up a study, it is usual for the user to first choose the study properties, and then
define the airports to be used followed by the scenarios. However, if comparing different, but
similar, airport layouts, say for instance because of a contemplated runway addition or extension,
the user could first define all the airport features in the baseline scenario, and then use the
duplicate scenario option (available by right-clicking the scenario name in the study tree), which
will copy all of the already defined airport features, emissions sources and scenario options into a
new scenario.

Study properties such as Unit System apply to the whole study. For example, selecting Metric
units will cause all fields on all dialogs and views to display and/or accept metric units.

Under the scenario properties, System Aircraft Times in Mode Basis and Taxi Time Modeling
Options alter the method used to compute those parameters within that scenario.

The selection of certain options within the study can also affect the availability of options in other
parts of EDMS. The most significant of these restrictions are the enabling of dispersion and the
selection of sequence modeling vs. using default taxi times, which are discussed below.
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1.3.4.1 Dispersion Related Restrictions

Dispersion is enabled or disabled by checking or unchecking, respectively, the Enable Dispersion
Modeling checkbox on the Study Properties dialog.

In order to perform dispersion modeling, EDMS has to know both when and where any emissions
took place. This requires that performance-based aircraft modeling (for airborne movement) and
sequence modeling (for taxiing) be used. So if dispersion is enabled, then on the Scenario
Properties dialog, under System Aircraft Times in Mode Basis, Performance Based will be
required while the ICAO/USEPA Default Times in Mode will be disabled, and under Taxi Time
Modeling Options, Sequence Modeling will be required, while the User-specified taxi times for
each aircraft option will be disabled. Consequently, requirements related to sequence modeling
(described in the next section) will always be in effect when dispersion is enabled.

Buildings are not considered to have emissions, but can affect airflow for dispersion. So the
Buildings option under the Airport menu is disabled when dispersion is not enabled. The
Dispersion menu and the Concentrations option under the View menu are also available only
when dispersion is enabled.

Dispersion also requires the use of hourly meteorological data. The Weather wizard, activated
under the Airport menu, has options of Use Annual Averages and Use Hourly Meteorological
Data. Use Annual Averages is disabled when dispersion is enabled.

1.3.4.2 Sequence Modeling Requirements

Sequence modeling is one of the Taxi Time Modeling Options on the Scenario Properties dialog,
and is required for dispersion, but can also be used for emissions inventories if a detailed
modeling of taxi emissions is desired. To use sequence modeling, the user must define the gates,
taxiways, runways, taxipaths, and runway configurations for the airport. Default taxi times are not
used with sequence modeling and that menu item is not available under the Airport menu.

If instead, User-specified taxi times for each aircraft has been selected, the airport features are
not needed and the associated menu items under the 4irport menu will be grayed out, but Default
Taxi Times will be enabled.

1.3.5 EDMS Screen Layout

The main study window is divided into two panes. The left-hand pane holds the study tree, which
reflects the study structure described above. Whichever node of the tree is selected is the one that
an open dialog will refer to. The right-hand pane shows the next set of nodes down in the tree, or
if at the lowest (year) level it shows how many of each emissions source or airport component
have been defined.

Menus pertinent to a node are available at all levels except the year level by right-clicking on the
node.

1.3.6 Functional Flow - Emissions

Overall, the fundamental usage of EDMS is to first perform an emissions inventory, after which
the user can chose to continue to model the dispersion of the emitted pollutants calculated. As
shown in Figure 1-4, to perform an emissions inventory the user would follow the following
steps:

1) Set up the study by adding scenarios and airports, and choose which modeling options
to use.
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2) Define all emissions sources, including operational usage.

3) Define the airport layout if sequence modeling was selected.

4) Select a weather option: annual average or hourly (requires running AERMET).
5) Select Update Emissions Inventory.

The simplest way to generate an emissions inventory and obtain a course estimate of the total
annual emissions is to perform the first two steps, and use the ICAO/EPA default times in mode
along with the default operational profiles, and the annual average weather from the EDMS
airports database. Doing so would only consider the total number of operations for the entire year
without regard to when those operations occurred.

NOTE: Conducting an emissions inventory in this manner is generally not sufficient for
obtaining FAA approval.

If a more precise modeling of the aircraft taxi times using the Sequencing module is desired
(required if dispersion will be performed), then the user must define the airport gates, taxiways,
runways, taxipaths (how the taxiways and runways are used) and configurations (weather-
dependent runway usage). The resulting emissions values can be viewed by selecting Emissions
Inventory on the View menu. These results can be printed by selecting Print under the File menu
while viewing the emissions inventory.
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Figure 1-4: EDMS Functional Flow
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1.3.7 Functional Flow - Dispersion

To run a dispersion analysis, the user must first generate an emissions inventory while dispersion
is enabled. Because of this, the methodology used for generating the emissions inventory is also
the same one used to calculate the emissions for dispersion purposes. This inventory will take
many times longer than the same one without dispersion enabled, because EDMS must generate
(.HRE) files which contain all of the emissions broken into hourly bins by source and the (.SRC)
files that define all the sources. Also, enabling dispersion forces the selection of Performance
Based times in mode, Sequence Modeling and hourly meteorological data.

In addition, to run dispersion the user must define receptors, which are points at which the
concentration of pollutants will be computed.

Next, the user can optionally run AERMAP, which will adjust the elevations of all emissions
sources and receptors to the terrain data supplied. This will override any user-defined elevations
that had been entered.
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Next, the user must specify the AERMOD run options and generate the AERMOD input (.INP)
files.

And finally, the user runs AERMOD within the EDMS GUI to generate the concentrations at the
receptors.

The resulting concentrations can be viewed by selecting Concentrations under the View menu.
These results can be printed by selecting Print under the File menu while viewing the
concentrations.

1.3.8 Features and Limitations

EDMS incorporates both EPA approved emissions inventory methodologies and dispersion
models to ensure that analyses performed with the application conform to EPA guidelines. Since
EDMS is primarily used in the process of complying with EPA air quality requirements (e.g.
through an environmental impact statement) it is imperative that the application uses the most
current data available. For this reason, it is the FAA’s intention for the database to contain a
comprehensive list of aircraft engines, ground support equipment, aerospace ground equipment,
auxiliary power units, vehicular, and stationary source emission factor data. However, there may
be cases where the database does not contain a specific data element (e.g. a newly available
emission factor). In these cases, EDMS tries to make allowances for the user to enter their own
data and will perform parameter validation where possible. The pollutants currently included in
the emissions inventory are CO, THC, NMHC, VOC, NOx, SOx, PM-2.5" and PM-10". Other
pollutants such as lead, ozone, and hazard air pollutants have not been included in the application
due to several reasons including lack of available data, the lack of approved methodology, or
analysis boundary (e.g., EDMS analyzes emissions and dispersion in a local area on the airport
but addressing ozone would require a regional analysis).

EDMS performs dispersion analysis by generating input to EPA’s AERMOD dispersion model,
and provides an interface to the complex terrain module of AERMOD. To use this function, the
user can run AERMAP (the AERMOD terrain pre-processor) as a part of EDMS. The pollutants
currently included in EDMS for dispersion analysis are CO, THC, NMHC, VOC, NOx, SOx,
PM-2.5" and PM-10". Concentrations of the included pollutants are generated for comparison
with all the Primary NAAQS and most of the Secondary NAAQS.

' PM-10 and PM-2.5 emission factors are only available for ground support equipment, on-road vehicles,
stationary sources, and training fires.
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2 Emissions Calculations

An emissions inventory is a summary of the total annual emissions of the modeled pollutants for
the sources defined in a study. Depending on the purpose of the study, the emissions inventory
may be an end in itself or an intermediate step towards performing a dispersion analysis.

EDMS calculates emissions of eight pollutants:

CO (carbon monoxide),

THC (total hydrocarbons),

NMHC (non-methane hydrocarbons),
VOC (volatile organic compounds),

NOx (nitrogen oxides),

SOx (sulfur oxides),

PM-10 (particulate matter, 10 microns) and
PM-2.5 (particulate matter, 2.5 microns).

NGO E

2.1 Data Input Overview

The Study Properties window allows the user to specify whether the current study will be used to
generate only an emissions inventory (Enable Dispersion Modeling not checked), or an emissions
inventory and a dispersion analysis (Enable Dispersion Modeling checked). If dispersion is not
enabled, then only the inputs required for conducting an emissions inventory will be editable on
each of the windows, but more modeling options will be available since there are fewer
restrictions.

To enter data for a specific type of source (e.g. aircraft, stationary sources, etc.), click on the
scenario, airport, and year combination on the study tree view and select the appropriate source
type from the Emissions menu. The menu options are described in more detail in (Chapter 6).

The parameter values for individual records are displayed by selecting the record in the In Study
list box. These values may then be modified. Changes made to a record are remembered while
accessing a different record, but changes are not applied unless the Apply button is pressed.
Exiting a window without pressing Apply will result in all changes being discarded. Parameter
validation is built into the interface, so in the event of



EDMS models aircraft activity with 6 modes of operation corresponding to the following portions
of a Landing-Takeoff (LTO) cycle. These modes of operation only apply to the aircraft main
engines; APU emissions are calculated and presented separately.

1. Approach: The airborne segment of an aircraft’s arrival extending from the start of
the flight profile (or the mixing height, whichever is lower) to touchdown
on the runway.

2. Taxiln: The landing ground roll segment (from touchdown to the runway exit) of
an arriving aircraft, including reverse thrust, and the taxiing from the
runway exit to a gate.

3. Gate: Aircraft main engine startup. Even though APUs and GSEs assigned to
aircraft physically release emissions at the Gate, their emissions are not
included in the aircraft Gate mode of operation, and are instead reported

separately.
4. TaxiOut: The taxiing from the gate to a runway end.
Takeoff: The portion from the start of the ground roll on the runway, through

wheels off, and the airborne portion of the ascent up to cutback during
which the aircraft operates at maximum thrust.

6. Climb Out: The portion from engine cutback to the end of the flight profile (or the
mixing height, whichever is lower).

Each aircraft activity is expressed as either an Arrival, a Departure, an LTO cycle, or a Touch and
Go (TGO), and each type consists of different modes of operation. An Arrival consists of the
Approach and Taxi In modes. A Departure consists of the Gate, Taxi Out, Takeoff, and Climb out
modes. An LTO cycle consists of an Arrival and a Departure, and therefore consists of one of
each of the six modes of operation. A TGO consists of the Approach mode, followed immediately
by the Takeoff and Climb out modes. TGO operations are generally performed for training
purposes, usually occur at military bases or smaller civilian airports, and generally have a flight
profile that starts and ends at a much lower altitude than a regular LTO cycle.

EDMS offers two ways of calculating the amount of emissions released in the airborne segments
and approach ground roll:

1. Using the International Civil Aviation Organization (ICAO) and Environmental
Protection Agency (EPA) Times in Mode (TIM) found in a table, or

2. Using the aircraft performance module, which dynamically models the flight of the
aircraft, based a flight profile using the methodology presented in the Society of
Automotive Engineers (SAE) Aerospace Information Report (AIR) 1845.

The user selects the methodology, in the Scenario Properties window, to be applied to all aircraft
in the system database.

NOTE: The dynamic aircraft performance-based modeling option should always be
used in airport analyses conducted for FAA approval unless prior authorization
is obtained from the FAA’s Office of Environment and Energy.

The ICAO/EPA TIMs are based on broad aircraft categories and provide more generalized times
spent in each of four modes: Approach, Idle, Takeoff, and Climb Out. The emissions determined
from these four ICAO modes are allocated to the various EDMS modes of operation as follows:
the ICAO Approach, Takeoff, and Climb Out modes are allocated to the EDMS Approach,
Takeoff, and Climb Out modes of operation, respectively, while the ICAO Idle mode is broken
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down into the EDMS Taxi In and Taxi Out modes of operation. The ICAO TIMs have no flight
profiles associated with them, and they only determine the amount of time that an aircraft spends
in each mode, not its position. Because there is no spatial information on the release of emissions
when using the ICAO TIMs, this modeling option is not allowed when dispersion is enabled.
Instead, use of the performance-based methodology is required when dispersion is enabled.

The dynamic aircraft performance module provides more precise and accurate modeling of
aircraft performance by taking into account the aircraft type, engine, weight, approach angle to be
flown (for arrivals), elevation and weather (atmospherics). Using hourly meteorological weather
data, variations in the thrust used (and emissions released) for the same aircraft can be observed
at different times of the day and at different airports due to the changing weather conditions.
When user-created aircraft are added to a study, the user can enter aircraft-specific times for the
takeoff, climb out, approach and landing idle modes or assign a flight profile from a similar
aircraft in the system table.

For the EDMS Taxi In and Taxi Out modes of operation, the taxi times can either be user-
specified or generated by the sequencing model. The latter is required when dispersion is enabled.

Mixing heights less than 1,000 feet are not allowed in EDMS. The default approach and climb out
times in mode of both system aircraft using ICAO/EPA TIMs and user-created aircraft are based
on a mixing height of 3,000 feet but are adjusted to reflect the user-specified local mixing height.
When the mixing height in the Weather window is modified, the times-in-mode for all aircraft are
automatically adjusted.

Aircraft engines are the actual source of emissions for aircraft. EDMS treats each aircraft as a
combination of a specific aircraft type and engine type. For each aircraft type there may be
several different engine types available for use and emission factors may vary from engine to
engine. Consequently, different aircraft may generate identical emissions because they are
equipped with identical engines, or older aircraft may be outfitted with technologically newer
engines and generate fewer emissions. Default engines (displayed in bold) represent an actual
engine type which is the most common or the most widely used engine type for that particular
aircraft type in the United States, Europe or worldwide fleet based on recent data extracted from
the BACK aviation database. More information on the data used to determine the default engines
is available from www.backaviation.com.

In each of the modes, the engines operate at correspondingly different power settings. The power
settings determine the rate at which fuel is burned which, in turn, determines the quantity and
nature of emissions released into the atmosphere.

For most engines the emission factor data was obtained from the ICAQO Aircraft Engine Exhaust
Databank, a publicly available database that can be downloaded from www.ginetig.com. The data
from QinetiQ is supplemented by engine emissions data provided directly from the manufacturer
and, for older aircraft, data contained in EPA’s AP-42, Part Il, Section 1.

2.21 Aircraft Operations & Schedule

Operational information for aircraft can be entered in one of two ways: (a) by specifying the
number of annual operations or peak quarter-hour operations for each aircraft, along with
operational profiles showing the relative activity by quarter-hour, day-of-the-week and month, or
(b) by specifying a schedule of operations. In the first method, peak quarter-hour operations are
converted into a pseudo-schedule using the selected operational profiles. From that point on, both
methods are essentially the same.


http://www.backaviation.com/
http://www.qinetiq.com/

222 Taxi Times and Sequence Modeling

In the Scenario Properties window, there are two options for determining the amount of time an
aircraft spends taxiing: User-specified taxi times for each aircraft and Sequence Modeling. With
user-specified taxi times, the user can define defaults for taxi in and taxi out times that apply to
each aircraft added to the study. These taxi times can then be changed for each aircraft as desired.
However, because these user-specified taxi times do not have any information on the location at
which the taxiing occurs, this modeling option is not allowed when dispersion is enabled. Instead,
the Sequence modeling option is required in order to provide the spatial taxiing information.

Sequence modeling in affect performs a simulation to dynamically determine the taxi times, and
is required for dispersion, but can also be used for emissions inventories. To use sequence
modeling, the user must define the gates, taxiways, runways, taxipaths, and runway
configurations for the airport.

The Sequence module determines the active runway configuration that is used at each hour of the
year based on meteorological information and the user-specified activation parameters in order to
determine the associated airport capacity at each hour of the year. This airport capacity
information along with demand information from the aircraft operational profiles or schedule are
provided to the WWLMINET delay model to determine the airport throughput. EDMS then
adjusts the estimated gate push-back time (for departures) and estimated touchdown time (for
arrivals) into actual times that are possibly delayed.

The Sequencing module models the movement of aircraft along the taxiways (as prescribed by
the taxipaths) between runways and gates for both arriving and departing aircraft. In addition,
modeling of taxi queuing is then done for departing flights, but not arriving aircraft, which are
assumed to have unimpeded taxi in to their gate. The departure aircraft are sequenced in the
proper order to provide the duration that each aircraft spends on each taxiway segment. The
aircraft form queues along the taxiways that feed into the corresponding runway-ends. This
detailed modeling of the usage of individual taxiway segments during taxi in and taxi out
provides a more realistic modeling of airside operations for both emissions inventory and
dispersion purposes.

2.3 Ground Support Equipment (GSE) and Auxiliary Power Units (APUS)

Emissions are generated by ground support vehicles and auxiliary power units (APUs) while the
aircraft is parked at the gate. The following sections cover Ground Support Equipment (GSE) and
auxiliary power units (APUSs). GSE can be modeled both by assignment to an aircraft and by
population. GSE that are assigned to an aircraft will have their operations depend on the activity
of that aircraft. GSE that are modeled as a population operate independently from aircraft activity.
Since APUs are onboard aircraft, they are always modeled based on an aircraft’s activity.

GSE emission factors used by EDMS are derived from EPA’s NONROAD2005 model and are
based on the following variables: fuel, brake horsepower and load factor. In addition, a
deterioration factor is applied based on the age of the engine. GSE emission factors are given in
grams per horsepower-hour. EDMS allows users to select the EPA-derived national fleet average
age for a particular vehicle type, or to specify the exact age of an individual piece of equipment.

2.31 GSE Assigned to Aircraft

Upon arrival at a gate, aircraft are met by GSE to unload baggage and service the lavatory and
cabin. While an aircraft is parked at a gate, mobile generators and air conditioning units may be
in operation to provide electricity and conditioned air. Prior to aircraft departure, GSE are present
to load baggage, food and fuel. When an aircraft departs from a gate, a tug may be used to push



or tow the aircraft away from the gate and to the taxiway. Figure 2-1 depicts aircraft and GSE
activity at the gate.

Figure 2-1. Aircraft with GSE.

GSE that are assigned to an aircraft are given times (minutes per arrival, minutes per departure)
based upon the type of service. For example, a fuel truck servicing a large commercial aircraft
will have a different operating time than the same fuel truck servicing a commuter aircraft. Tugs
are generally used to move commercial aircraft away from the gates, but are typically not used by
general aviation (GA) aircraft.

As system aircraft are added to the study, default GSE assignments are made for each newly
added aircraft. Default assumptions are used in EDMS, but the user also has the flexibility to add
and remove GSE to and from aircraft and modify the operating times as well as other parameters
for assigned GSE. These default assignments are based upon several categories of aircraft types
(e.g., wide body jets, cargo planes, commuter aircraft, general aviation, military jets, military
transports, business jets, etc.).

If site-specific information is available for GSE (assignments and operational times), it is
recommended that this data be used in place of the default values. If the aircraft type is removed
from the study, all the GSE assigned to it will also be removed from the study. To modify the
assignment and/or the operating times of these sources; select the GSE & Gate Assignment tab on
the Aircraft Operations & Assignments Window.

GSE emissions generated per LTO cycle (or arrival or departure) are the product of the emission
factor, horsepower, load factor and operating time. For annual emissions this result is multiplied
by the number of yearly LTO cycles (or arrivals and departures) for the aircraft to which the
equipment is assigned. GSE emissions are not calculated for TGO operations.

2.3.2 GSE Populations

For a population of GSE, the annual GSE emissions are the product of the emission factor for the
given pollutant, horsepower, load factor, annual usage and population. The analyst can either
select "Use default age distribution™, which will cause GSE to be modeled with the national
average GSE emission factors that were developed by the U.S. EPA using NONROAD2005, or
can select "Specify a specific age", which will apply the NONROAD2005 emission factors for a
specific vehicle. In the latter case, the fuel, the horsepower and the year of manufacture determine
the zero-hour emission factor and the age and GSE type determine the deterioration to be applied.

233 Auxiliary Power Units (APU)

Auxiliary power units (APUs) are most often on-board generators that provide electrical power to
the aircraft while its engines are shut down. Some pilots start the on-board APU while taxiing to



the gate but, for the most part, it is started when the aircraft reaches the gate. The on-board APU
is, in effect, a small jet engine and the calculations for the emissions generated by it are similar to
that of an aircraft engine operating in one power setting only. The methodology for calculating
emissions from APUs is adapted from the U.S. EPA's Procedures for Emission Inventory
Preparation, Volume IV, Chapter 5, which can be found at www.epa.gov/otag/invntory.htm. Like
GSE, APU emissions generated per LTO cycle are the product of the emission factor and
operating time, multiplied by the number of applicable aircraft LTO cycles. APU emissions for
arrivals and departures are computed in a like manner, when those are treated separately. For the
purpose of emissions calculations, APUs are assigned to the same category as GSE. External
APUs used by an aircraft fall into the category of ground support equipment. In the absence of an
APU or applicable GSE, a combination of 400 Hz electric power and preconditioned air (PCA)
can be supplied to the aircraft using a fixed system at each gate to allow for normal operation.
Fixed systems usually generate little or no emissions at the airport and are not included in EDMS.
APU emissions are not calculated for TGO operations.

2.4 On-Road Vehicles

Motor vehicle activity on roadways is specified in the Roadways window under the Emissions
menu heading. The Traffic Volume (Yearly or Per Peak Quarter Hour) refers to the number of
vehicle traversals (one-way trips) on the roadway. The average speed (in mph) of vehicles
traveling on the roadway (Average Speed) is one of the parameters necessary to determine a
MOBILE 6.2 emission factor (grams/vehicle-mile) for the movement of the vehicles. The other
three parameters are Manufactured Year, elevation (Height), and the average daily high and low
temperatures, which come from the airport’s weather data. Additionally, MOBILE 6.2 allows the
user to choose between the default fleet mix and one of the 16 vehicle types. Selection of a
specific vehicle type will cause EDMS to assume that the roadway is used only by vehicles of the
specified type.

The Roadway Length field is used exclusively for emissions inventory purposes to determine the
total amounts of pollutants generated by vehicles traveling the length of the roadway on their way
to and from the airport. Specify the total distance (in units set on the Study Properties window) a
vehicle would be expected to travel along the selected roadway. For a dispersion analysis, the
Roadway Length is computed from the coordinates of the points that define the roadway, and is
not editable. Access to the roadway emission factors for the active record both for viewing and
editing purposes are on the lower right corner of the window. The total emissions for a roadway
are the product of the emission factors (given in grams per vehicle-mile), the annual Traffic
Volume, and the Roadway Length.

Important: Unlike EDMS 4.x, EDMS 5.0 does NOT assume that vehicles travel “round-trip” (i.e.
does not assume that each vehicle traverses a roadway once in each direction). So to indicate the
round-trip passage of 100,000 vehicles, a yearly Traffic Volume of 200,000 should be entered.

Vehicular emission factors contained in EDMS are obtained from the EPA's MOBILE 6.2. To
accommodate changing and/or varying regulations or the need for a more detailed analysis, the
user has the option of entering their own vehicular emission factor data. Frequently, the user
would obtain this emission factor data by running MOBILE with customized input.

Once the user has provided EDMS with the analysis year, temperature, elevation, vehicle speed
and class, MOBILE will run using the default settings. The control flag settings used by EDMS
for MOBILE 6.2 are summarized in (Table 2-1). The EDMS Technical Manual contains
additional information about how EDMS models on-road vehicle emissions along with
instructions on viewing the MOBILE input file generated by EDMS and the output received from
MOBILE in return. Users should run MOBILE outside of EDMS, if they find that these defaults
are not appropriate for their airport.



Table 2-1: MOBILE 6.2 Control Flag Settings.

Control Flag Value(s)

Gasoline fuel Reid Vapor Pressure (RVP) 11.5 psi for study years prior to 2009
8.7 psi for study years 2009 and later

Minimum daily temperature Average ambient temperature from the study setup
screen — 10.35°F

Maximum daily temperature Average ambient temperature from the study setup
screen + 10.35°F

Calendar year Study year from the study setup screen

Evaluation month 7 (July)

Roadway type Arterial

Altitude “1” if the airport elevation is less than 5,000 feet

above sea level

“2" otherwise

25 On-Road Vehicles in Parking Facilities

Motor vehicle activity in parking facilities is specified in the Parking Facilities window (under
the Emissions menu heading). The Number of Vehicles (Yearly or Per Peak Quarter Hour) refers
to the distinct number of individual vehicles using the parking facility. An entry and an exit of the
parking facility with any idling and vehicle movement together, count as one operation. The
average speed of vehicles traveling in the parking facility (Speed) is one of the parameters
necessary to determine the emission factors for the movement of the vehicles using MOBILE 6.2.
The three remaining parameters are, Manufactured Year, Elevation, and the average daily high
and low temperatures, which come from the airport’s weather data. MOBILE 6.2 does however
allow the user to choose between the default fleet mix and one of the 16 vehicle types. Selection
of a specific vehicle type will cause EDMS to assume that the parking facility is used only by
vehicles of the specified type.

Note: In order to define a custom fleet mix of on-road vehicles, users must either run MOBILE
outside of EDMS and import the resultant emission factors, or make a copy of the parking facility
or roadway for each of the vehicle types.

Idle emission factors (grams/vehicle) are computed by extracting emission factors, as above, with
a vehicle speed of 2.5 mph and multiplying these factors by the Idle Time. The input for the idle
time is an estimate of the average time a vehicle spends idling between entry and exit. The input
for Distance Traveled is an estimate for the average distance a vehicle travels between entry and
exit. This field is used to modify the moving emission factors (grams/vehicle-mile). The moving
emission factors and the idle emission factors are combined to produce a parking facility emission
factor (grams/vehicle).

2.6 Stationary Sources

The EDMS database contains emission factors for several categories of stationary sources. Each
broad category is further broken down into several specific types. The ten categories currently
included are Boiler/Space Heaters, Emergency Generators, Incinerators, Aircraft Engine Testing,
Fuel Tanks, Surface Coating/Painting, Deicing Area, Solvent Degreasers, Sand/Salt Piles and
Other.




Users can specify the category specific (and in some cases type specific) emissions parameter
values or use the default emissions parameter values. The specific methodologies for computing
stationary source emission factors are presented in Appendix H of Air Quality Procedures for
Civilian Airports and Air Force Bases (the Air Quality Handbook). The general methodology for
calculating emissions from these sources considers the amount of fuel or substance consumed.

The Stationary Sources window under the Emissions menu heading is used to specify stationary
source activity. After the selection of a Category, the first type is automatically selected from
Type drop down menu and the Emission Parameters list is populated with the appropriate
parameters, including the emission factors. Typically the user will then select a Type that best
matches the source that they wish to include in the study. The Category and Type fields are keys
to retrieve default data from the database.

Based upon the nature of the fuel, the substance consumed, or throughput, emission factors are
displayed either as Kg/Metric Ton, Kg/Kiloliter, Kg/Thousand Cubic Meters, Kg/Hour or Kg/Test
Cycle. Emission factors and parameters may be modified if the user obtains site-specific data, but
there is no validity checking performed to verify that the modified emission factors are actually
valid for the selected Category and Type.

The Yearly and Per Peak Quarter Hour values specify the amount of time, fuel or substance
consumed or throughput, and these are specified in Metric Tons, Kiloliters, Thousands of Cubic
Meters, Hours or Test Cycles as appropriate. EDMS gives the user the flexibility to identify
generic stationary sources. For miscellaneous stationary sources, the user has the option of
choosing the Other category and entering their own emission factors in their choice of units. For
such sources, the user is required to provide user-specified emission factors.

2.7 Training Fires

Training fire activity is specified by selecting the Training Fires window under the Emissions
menu heading. Emission factor data for five fuels (JP-4, JP-5, JP-8, Tekflame and Propane) are
stored in the EDMS database and may be selected from the Fuel drop down list. Training fire
emission factors are specified in the system table FUEL_EF.dbf in kilograms of pollutant per
gallon of fuel used; and hence, the training fire activity values are always entered in Gallons of
Fuel Used. Training fire emission factors may be modified in the lower portion of the window
under Emission Factors, however there they are displayed in grams of pollutant per gallon of
fuel.

The Training Fire dialog shows only five emission factors, rather than eight. The emissions from
HC (hydrocarbon) are used for all three of the categories THC, NMHC and VOC in the emissions
inventory, and the PM10 emissions are used for both PM-10 and PM-2.5.

2.8 Emissions Inventory Output

The following sections describe the components of the emissions inventory, and the outputs
available to the user. EDMS allows the analyst to view the emissions inventory on the window in
an interactive manner and to print a formal emissions inventory report. EDMS generates an
emissions inventory for the following pollutants: CO, THC, VOC, NMHC, NOx, and SOx for all
sources. In addition, PM10 and PM2.5 emissions are inventoried for all sources except APU. The
total fuel consumption is also calculated and displayed for the Aircraft by Mode and Aircraft
Summary.

2.8.1 Emissions Inventory

An emissions inventory is a summary of the total pollutants generated by all active sources in the
study. Using EDMS to perform an emissions inventory requires the user to identify the emission
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sources, the annual activity for each of these sources and, in the case of user-defined sources, the
emission factors. EDMS then calculates the total annual pollutant emissions for each of the
identified sources and presents it in both a summarized report and a detailed report.

2.8.2 View Emissions Inventory

The View Emissions Inventory window is displayed by selecting the appropriate option under the
View menu heading. The initial display is the Summary, which shows total pollutant emissions by
source category in tons, short tons, Ibs, or kilograms per year as specified in the Study Setup. The
units can be changed by selecting the desired unit from the Units drop down box. In addition, the
analyst can view emissions for specific scenario, airport, and years by selecting the desired
scenario-airport combination and the desired year from the Scenario-airport and Year drop-down
boxes.

The source categories are: Aircraft (broken down by mode of operation), APU, GSE, Stationary
Sources (including Training Fires), Vehicular sources (both Roadways and Parking Facilities),
and the total of all categories. The analyst may also view total pollutant emissions by each source
type by clicking on the appropriate buttons at the top of the view window.

The Aircraft by Mode display lists the total pollutants by the contributions of aircraft type in each
mode of operation. The possible modes are Approach, Taxi In, Gate, Taxi Out, Take Off and
Climb Out. APU and Assigned GSE emissions may be viewed by pressing the Aircrafi/APU
button. The aircraft’s Total emissions are the sum of all six modes due to the aircraft's activity.
The Assigned GSE and APU totals are displayed separately. The GSE Population display shows
the emissions for each item in the GSE population. The Vehicular Sources display lists the total
emissions for each roadway and parking facility included in the study while the Stationary
Sources display lists the total emissions for each stationary source or training fire specified in the
study.

2.8.3 Print Emissions Report(s)

To print official reports of the emissions inventory choose Print from the File menu while the
emissions view is selected. Aside from a difference in formatting, EDMS titles, and study
information, the contents of the emissions inventory reports are exactly the same as described in
View Emissions Inventory.
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3 AIRPORT LAYOUT

The Airport Layout defines the physical “fixed” infrastructure components of the airport around
and through which the airport sources operate. The airside network components include the
runways, gates, and taxiways, and are optional for performing an emissions inventory, but are
recommended if a precise calculation of inventory is desired, and are required for dispersion.
Buildings have no affect on emissions, but affect the dispersion of point sources.

In EDMS, users also have the ability to graphically view the layout of the airport, and interact
directly with the graphical airport view to place, move, and modify various sources.

3.1 Weather Data

The meteorological data settings can be found under the Weather option under the 4irport main
menu, and is specific to each scenario-airport combination. There are two settings available: 1)
annual average weather values, and 2) hourly weather values. If dispersion is not enabled, then
the user has the option of using either the annual averages or supplying his/her own hourly
weather files for the emissions inventory. Hourly weather data supports the aircraft performance
module and airport runway configurations to provide greater precision when performing an
emissions inventory, but if it is not available, the airport’s annual average values will be used for
all activities. If dispersion is enabled, then hourly weather data is required in order to provide the
precision necessary for detailed emissions and support the AERMOD dispersion module.

The following weather parameters are used by EDMS:
1. Mixing Height

2. Temperature (ambient, daily high, daily low)

3. Relative humidity

4. Wind direction

5. Wind speed

6. Sea level pressure

7. Cloud ceiling height

8. Horizontal visibility

If hourly weather data is used, the user must supply surface data for each hour, as well as twice-
daily upper-air observations, one of which must be an early morning sounding. Historical weather
data are available for free from the EPA internet site (www.epa.gov) and other locations, such as
www.webmet.com. Additionally, recent weather data are available from the National Climactic
Data Center (NCDC) internet site (www.ncdc.noaa.gov) for a fee. The surface and upper-air
observations are processed with the meteorological preprocessor, AERMET. The AERMET
Wizard, initiated from the Weather dialog, steps the user through loading the two types of
weather data and then merges them into a format that AERMOD can use. Three files are output
from the AERMET Wizard.

1. The AERMOD surface file (.SFC)
2. The AERMOD profile file (.PFL)
3. The intermediate AERMET surface observation file (MET)

The surface file and the profile file are used directly by AERMOD, and contain only the
meteorological parameters needed for dispersion purposes. The third file, the AERMET surface



http://www.epa.gov/
http://www.ncdc.noaa.gov/

observation file, is an intermediate output file by AERMET and retains all of the meteorological
parameters originally contained in the user-supplied surface data file, which is used by EDMS
directly to drive the aircraft performance and runway configurations.

Weather data must be provided in one of the formats listed in (Table 3-1); this may require
converting the weather data into one of the formats listed. If weather for a specific location is not
available, an appropriate substitution should be used.

Table 3-1. Acceptable Weather Data Formats

File Format Use Description Source

TD-3280 Surface National Climactic Data
Center (NCDC).

Www.ncdc.noaa.gov

TD-3505 Surface National Climactic Data
Center (NCDC).

Www.ncdc.noaa.gov

CD144 Surface National Climactic Data
Center (NCDC).

Www.ncdc.noaa.gov

HUSWO Surface National Climactic Data
Center (NCDC).

Www.ncdc.noaa.gov

SCRAM Surface Environmental Protection
Agency.

www.epa.gov

SAMSON Surface National Climactic Data
Center (NCDC).

Www.ncdc.noaa.gov

TD-6201 Upper-Air National Climactic Data
Center (NCDC).

Www.ncdc.noaa.gov

Radiosonde Data of North Upper-Air National Climactic Data
America — FSL format Center (NCDC).

Wwww.ncdc.noaa.gov

3.2 Airside Network Layout

The physical components that comprise the airside network include the runways, the gates, and
the taxiways that link the two. In addition, taxipaths indicate the path through the taxiway
network which an aircraft will take to go between a runway and gate, and runway configurations
indicate the runways that will be active at a particular time of day based on weather conditions.
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These elements are necessary in order to model the delay and sequencing of aircraft as they
depart, and determine the amount of time each aircraft spends on each portion of the tarmac in
order to more precisely allocate the emissions to those areas for dispersion purposes. These
components are optional when only an emissions inventory is needed, but are required for
dispersion, and are discussed further below.

3.21 Runways

Aircraft runways are defined using the Runways dialog found under the 4irport menu heading.
Runways are named based on their magnetic orientation. For example, runway 9-27 is a runway
oriented east-west, with runway 9 defining aircraft moving west to east, and runway 27 defining
aircraft moving east to west. The Runways dialog allows the user to create runways with distinct
endpoints. This, in turn, allows the user to distinguish the direction of traffic on the runway when
defining taxipaths on the Taxipaths dialog and runway usage percentages on the Configurations
dialog.

3.2.2 Taxiways

Aircraft taxiways are defined through the Taxiways dialog found under the 4irport menu heading.
The coordinates of the taxiway identify a series of area sources for the placement of aircraft
movement while the aircraft is taxiing to and from a gate or a runway. The default taxi speed for
an aircraft in EDMS is 15 knots (27.78 kph, 17.26 mph).

3.2.3 Gates

A gate is a physical point of arrival and departure for an aircraft. The location of the gate can
affect the overall annual emissions inventory by changing the distance (and the associated
emissions) needing to be traversed between the gate and the runway. Gate locations are also used
to determine the placement of the dispersion sources for GSEs and APUs.

3.24 Taxipaths

A taxipath is a series of taxiways connecting a gate to a runway end (for “outbound” taxipaths) or
a runway exit to a gate (for “inbound” taxipaths). The sequencing model determines the time-
location coordinates of an aircraft as it moves along the taxiways that its assigned taxipath
comprises. These time-location coordinates are used to assign the aircraft’s emissions to the area
sources that represent the taxiways.

3.25 Configurations

Airports operate under different configurations - the pattern of aircraft arrivals and departures on
specific runways - over the course of a year depending on the weather, capacity, and noise
abatement issues. Whereas it is impossible to account for all the various factors that might
influence the definition of configurations at specific airports, it has been determined that most
often configurations are defined based on the wind parameters of direction and speed.

The Configurations dialog (under the Airport menu heading) provides a way for the analyst to
dynamically assign aircraft to different runways at run-time based upon weather conditions, time
of day, and aircraft weight category. Each configuration can have associated limits for any or all
of the following activation parameters:

1. Wind direction
2. Wind speed
3. Hour of the day



4. Cloud ceiling
5. Horizontal visibility
6. Temperature

The active configuration can be determined based solely on those parameters, or the user can
specify a distribution of percentage usage for the configurations, and EDMS will conform to that
distribution, while trying to satisfy the activation parameters of the configurations as well as
possible.

3.3 Airside Network Layout

The physical components that comprise the airside network include the runways, the gates, and
the taxiways that link the two. In addition, taxipaths indicate the path through the taxiway
network which an aircraft will take to go between a runway and gate, and runway configurations
indicate the runways that will be active at a particular time of day based on weather conditions.

These elements are necessary in order to model the delay and sequencing of aircraft as they
depart, and determine the amount of time each aircraft spends on each portion of the tarmac in
order to more precisely allocate the emissions to those areas for dispersion purposes. These
components are optional when only an emissions inventory is needed, but are required for
dispersion, and are discussed further below.

3.31 Runways

Aircraft runways are defined using the Runways dialog found under the 4irport menu heading.
Runways are named based on their magnetic orientation. For example, runway 9-27 is a runway
oriented east-west, with runway 9 defining aircraft moving west to east, and runway 27 defining
aircraft moving east to west. The Runways dialog allows the user to create runways with distinct
endpoints. This, in turn, allows the user to distinguish the direction of traffic on the runway when
defining taxipaths on the Taxipaths dialog and runway usage percentages on the Configurations
dialog.

3.3.2 Taxiways

Aircraft taxiways are defined through the Taxiways dialog found under the 4irport menu heading.
The coordinates of the taxiway identify a series of area sources for the placement of aircraft
movement while the aircraft is taxiing to and from a gate or a runway. The default taxi speed for
an aircraft in EDMS is 15 knots (27.78 kph, 17.26 mph).

3.3.3 Gates

A gate is a physical point of arrival and departure for an aircraft. The location of the gate can
affect the overall annual emissions inventory by changing the distance (and the associated
emissions) needing to be traversed between the gate and the runway. Gate locations are also used
to determine the placement of the dispersion sources for GSEs and APUs.

3.34 Taxipaths

A taxipath is a series of taxiways connecting a gate to a runway end (for “outbound” taxipaths) or
a runway exit to a gate (for “inbound” taxipaths). The sequencing model determines the time-
location coordinates of an aircraft as it moves along the taxiways that its assigned taxipath
comprises. These time-location coordinates are used to assign the aircraft’s emissions to the area
sources that represent the taxiways.



3.3.5 Configurations

Airports operate under different configurations - the pattern of aircraft arrivals and departures on
specific runways - over the course of a year depending on the weather, capacity, and noise
abatement issues. Whereas it is impossible to account for all the various factors that might
influence the definition of configurations at specific airports, it has been determined that most
often configurations are defined based on the wind parameters of direction and speed.

The Configurations dialog (under the Airport menu heading) provides a way for the analyst to
dynamically assign aircraft to different runways at run-time based upon weather conditions, time
of day, and aircraft weight category. Each configuration can have associated limits for any or all
of the following activation parameters:

1. Wind direction
2. Wind speed

3. Hour of the day

4. Cloud ceiling

5. Horizontal visibility
6. Temperature

The active configuration can be determined based solely on those parameters, or the user can
specify a distribution of percentage usage for the configurations, and EDMS will conform to that
distribution, while trying to satisfy the activation parameters of the configurations as well as
possible.

3.4 Airport View

The Airport option, under the View menu, provides the user the capability to visualize their
source and receptor placements in relation to each other. Runways are indicated by a thick gray
line with a solid blue centerline, taxiways are identified by a thick, gray line, roadways are
indicated by a solid red line and receptors are indicated by a flag pole. The ability to import an
airport’s “wallpaper” is also provided. The wallpaper can be any bitmap image, and is typically
the airport layout diagram or a map of the airport and the surrounding area.

The Airport View screen is a non-modal screen and hence the user may continue to add sources
and receptors in dialogs and view their placement in the display upon closing each dialog. All
sources can be dragged to their desired destination and modified from the Airport View by
double-clicking the source and making changes through the sources dialog box. To further aid the
user in verifying the coordinates and placement of components the position of the crossbar cursor,
in the coordinate system, is displayed in the status bar at the bottom of the display screen, and a
Scale is displayed in both the status bar and the legend. A limited zoom capability is also
provided. (Section 6.6.3) provides detailed information on how to interact with the Airport View.



4 DISPERSION CALCULATIONS

EDMS generates input files for use with EPA’s AERMOD dispersion model, its meteorological
preprocessor, AERMET, and its terrain preprocessor, AERMAP. AERMOD is a steady-state
plume model that assumes a Gaussian concentration distribution in both the horizontal and
vertical directions in the stable boundary layer. In the convective boundary layer, dispersion is
Gaussian in the horizontal direction, with the vertical direction being modeled by a bi-Gaussian
probability density function. It is not the intent of this user manual to describe AERMOD or any
of its associated preprocessors in detail. Detailed information about AERMOD is available from
user guides and additional information contained on the EPA’s internet site
(www.epa.gov/scram001/dispersion_prefrec.htm#aermod). The purpose of this manual is to
describe how EDMS is used to generate input files for AERMOD. The algorithms used by
EDMS to generate the AERMOD input files are described in the EDMS Technical Manual.

4.1 Inputs Required

The amount of data required to perform a dispersion analysis is significantly greater than the data
necessary for just an emissions inventory. All of the inputs necessary for the emissions inventory
are also necessary for dispersion modeling. In addition, some modeling options that are optional
for just emissions inventory are required when dispersion is enabled, including:

1. Accurate operational profiles or a schedule (see Chapter 2),
2. Aircraft performance modeling (see Chapter 2),

3. Aircraft delay & sequencing modeling (see Chapter 2),

4. Hourly weather data (see Chapter 3), and

5. Placement of receptors.

An emissions inventory must first be generated before dispersion can be performed, since the set
of emissions that are dispersed is the same as that produced from the annual inventory.

The dispersion algorithms use the selected operational profiles or aircraft schedule to vary the
source activity based upon time. It is important that accurate profiles be developed to represent
the variation of individual source activity as this can affect the outcome of dispersion
significantly. Two similar parameters found in all of the emissions source screens are the values
for Yearly and Peak Quarter Hour activity. The dispersion pre-processing routines use the Peak
Quarter Hour value in the computation of an emission rate. If the Yearly activity were the only
known variable then the user would use operational profiles to derive the Peak Quarter Hour
value. Upon entering the value for Yearly activity and choosing the appropriate Quarter Hourly,
Daily, and Monthly operational profiles the program will automatically compute the
corresponding Peak Quarter Hour value. Even if the Peak Quarter Hour value is known, and
entered directly, accurate operational profiles will still have to be defined and selected for each
source in the study. AERMOD itself uses hourly time bins. The use of quarter hours is only to
provide better fidelity from the aircraft sequence modeling.

Since EDMS is a model specifically developed for use at airports and air bases, there are several
screens that relate directly to the placement of aircraft and other source activity and movement on
the airport. Data input includes the creation and specification of runways, taxiways, buildings,
and gates. These inputs are converted into a collection of appropriate sources for modeling
dispersion in AERMOD.

4.1.1 Receptor Locations

The locations at which concentrations are estimated are known as receptors. EDMS allows the
placement of receptors in the Cartesian or Polar coordinate system with the ability to also specify
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the height of the receptors. EDMS does not perform any checking on the reasonableness or
accuracy of the placement of receptors; it is left to the users to verify this for themselves.

As a general rule, receptors should be located where the maximum total projected concentration
is likely to occur and where the general public is likely to have access. General guidance is given
in Volume 9 guidance (EPA, 1978b) for receptor siting:
o Places of expected maximum concentrations;
e Places where the general public has access over the time periods specified by the
NAAQS; and
e Reasonableness.
Examples of reasonable receptor sites might be:

o Sidewalks to which the general public has access on a more-or-less continuous basis;

e On the property lines of all residences, hospitals, rest homes, schools, playgrounds, and
the entrances and air intakes to all other buildings;
e Portions of a nearby parking lot to which pedestrians have continuous access.
Examples of unreasonable receptor sites might be:

e Median strips of roadways;

e On or close to an aircraft runway or taxiway;

e Within intersections or on crosswalks at intersections;
e Tunnel approaches;

e Within tollbooths; and

e A location far from the breathing height (1.8 m) at which the general public will not have
access.

The Receptors dialog, found under the Dispersion menu heading, allows the user to place
individual receptors or networks of receptors for concentration estimation. Dispersion
calculations will include all receptors in the In Study list box. The EPA recommended height for
receptor placement is breathing height (approximately 1.8 meters or 5.9 feet).

The Receptor Networks tabs on the Receptors dialog box allow the user to define two-
dimensional grids of individual receptors over a rectangular region (Cartesian) or an annular
sector (polar) of the airport or study area. Due to the increased computational time required for a
large number of receptors, the primary use of grids has typically been in screening dispersion
estimates.

4.1.2 Elevation

EDMS sources, except aircraft, and airport layout components have an associated elevation field.
The elevation acts as a base to which the release height for emissions is added to determine the
initial vertical location of emissions. Running AERMAP supersedes the user-supplied elevations
in the AERMOD input files with elevations from a Digital Elevation Model formatted file, but
does not replace the user’s elevation in the study data.

4.2 Dispersion Modeling Calculation

The intent of dispersion modeling is to assess the air pollutant concentrations at or near the airport
or air base resulting from identified emissions sources. These pollutant concentrations are
calculated to determine whether emissions from the site result in unacceptably high air pollution
levels downwind by comparison with the National Ambient Air Quality Standards (NAAQS) or
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other relevant air quality standards. To perform dispersion modeling, EDMS requires the
coordinates (in meters or feet relative to the user-specified origin) of each emissions source, the
specification of an emissions rate (derived from emission factors) and its variation through time.
For some sources, the release height, temperature and gas velocity are also required. The
identification of spatial points in the coordinate system for concentration estimation (receptors),
and the availability of weather data for individual hours are also required.

The basic Gaussian equation, a mathematical approximation that simulates the steady-state
dispersion of pollutants from a continuous point source is given below.

Equation 4-1: Gaussian Approximation?

A2 Joo]-3(227
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where:
C = point concentration at receptor, in ug/m?
(x,y,2) = ground level coordinates of the receptor relative to the source and wind
direction, in meters
H = effective release height of emissions, in meters (m)
= mass flow of a given pollutant from a source located at the origin, in ug/s

u = wind speed, in m/s
Oy = standard deviation of plume concentration distribution in y plane, in m
o = standard deviation of plume concentration distribution in z plane, in m

The results of the AERMOD dispersion calculations are the concentrations, given in micrograms
per cubic meter (ug/m?), at receptors for each hour. The following describes dispersion data
inputs and outputs.

4.2.1 Point, Area, and Volume Sources

Just as the emissions inventory breaks down airport operations into source categories, the same
applies to dispersion calculations. For dispersion modeling purposes, each source category is
assigned one of three source type categories: point, area or volume. EDMS uses all three source
types in AERMOD.

Stationary sources such as power plants release pollutants into the atmosphere through a point
source discharge mechanism such as a stack (training fires are also treated as point sources). The
AERMOD point source module is used to model dispersion for all point sources in EDMS. Point
source emission rates are generally given in grams per second (gm/sec).

Area sources are generally defined as an area with a uniform rate of emissions over the entire
surface. Parking facilities are classified as area sources in the model. Airport parking facilities
generate emissions due to on-road vehicles operations and vehicle idling. Area source emission

2 Source: Air Quality Procedures for Civilian Airports and Air Force Bases, FAA/USAF, Washington, DC,
1997.
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rates are generally given in grams per second per square meter (gm/sec-m?). In the case of a
multi-level parking facility, area sources are stacked at a defined increment to characterize the
structure.

Aircraft taxiing, aircraft queuing, aircraft accelerating on the runway, and on-road vehicle
operations are considered to be a series of area sources, since their movement along a path
approximates a line of continuous emissions. Similarly, aircraft after takeoff and during the
landing approach are also represented as a series of area sources. The area source was selected, as
opposed to using a series of volume sources based on recommendations from the American
Meteorological Society/EPA Regulatory Model Improvement Committee (AERMIC).

In EDMS the activity at gates are considered to be volume sources when the emissions from GSE
and APUs are estimated to originate from a single point of discharge, and area sources when
multiple points are used to model the gate. The latter case is typically used when a terminal or
part of a terminal is represented as an EDMS “gate.”

4.2.2 Aircraft

Aircraft activity is specified in the Aircraft Operations and Assignments dialog. The additional
data required for dispersion analysis (other than operational profiles) are assigned in the
Performance and GSE & Gate Assignment tabs in the Aircraft Operations and Assignments
dialog. The Taxi Out and Taxi In fields are not used in dispersion calculations; they are used
solely for the emissions inventory. This permits users only interested in generating an emissions
inventory to avoid having to define an airport layout. For dispersion, taxi in and out times (and
their corresponding locations on the taxiway network) are determined from the delay and
sequencing module. As discussed in (Chapter 2), aircraft have six modes of operation, and each
mode is represented by AERMOD area sources as follows:

1. Approach: A vertical 2-dimensional grid of area sources extending along the runway
center line starting at 1,000 ft down to the runway end representing the airborne approach
path. The approach path from the mixing height to 1,000 ft is collapsed into a single
horizontal row of area sources halfway between 1,000 ft and the mixing height.

2. Taxi In:The landing ground roll is attributed to the Runway source and the taxi in is
attributed to the Taxiway sources.

3. Gate: Aircraft main engine startup emissions and assigned GSE and APU are attributed to
the Gate source.

4. Taxi Out: The Taxi Out is attributed to the Taxiways source.

5. Takeoff: The takeoff ground roll is attributed to the Runway sources, while the airborne
portion is attributed to a vertical 2-dimensional grid of area sources extending along the
runway center line starting at the runway end representing the airborne departure path,
from the runway up to 1,000 ft. The departure path from 1,000 ft to the mixing height is
collapsed into a single horizontal row of area sources halfway between 1,000 ft and the
mixing height.

6. Climb Out: Uses the same vertical two-dimensional grid as the airborne Takeoff
segments.

Because the vast majority of the dispersion concentrations are attributed to the emissions released
by aircraft below 1,000 ft, the approach and departure spaces use a detailed vertical 2-
dimensional grid below 1,000 ft. However, in order to improve the computer run time, aircraft
sources between 1,000 feet and the mixing height are collapsed into the plane halfway between
1,000 feet and the mixing height.
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4.2.3 Gates, GSE, and APU

For the purposes of dispersion modeling, the emissions contributions due to aircraft main engine
startup (contained in the aircraft Gate mode of operation), GSE, and APUs are localized at the
gate to which the aircraft is assigned. The gate coordinates provide the spatial location in the
coordinate system from which all these sources are considered to emanate. The dispersion from
the sources at the gate is represented by a single volume source for each gate if only one point is
specified to define the gate; otherwise an area source is used to represent the gate. For larger
airports, many users represent a series of gates or part of a terminal as an individual gate in their
EDMS study.

4.2.4 Runways

Runways determine the location at which aircraft will operate and release emissions during the
ground roll for takeoff and landing. In addition, each runway end serves as the anchor point for
the 2-dimensional vertical profile for the aircraft approach and takeoff grids from which
emissions will be released for dispersion purposes as the aircraft approaches and takes off.

4.2.5 Taxiways

Taxiways determine the ground segments where the aircraft operates at idle thrust and releases
emissions whilst taxiing between the gates and runways.

4.2.6 Parking Facilities

Parking lot and parking garage activity is specified in the Parking Facilities. The additional data
required for dispersion analysis is found in the Dispersion Parameters box of the Parking
Facilities dialog. The parking structure must be defined as a series of up to 20 points. The parking
facility Height is specified to represent the height at which emissions are released. Each parking
facility may also have up to 20 levels. Facilities with multiple parking levels are modeled using
stacked area sources.

4.2.7 Roadways

Vehicle activity on roadways is specified in the Roadways dialog. The additional data required
for dispersion analysis is found in the Coordinates box. Aside from the coordinates that define the
path of the roadway, the height and width of the roadway must also be specified. These values
correspond to the release height and width of the emissions and not the physical dimensions of
the roadway. Roadways are modeled as a series of area sources by AERMOD.

4.2.8 Stationary Sources
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4.2.9 Training Fires

Training fire data are used by EDMS in both emissions and dispersion analyses. For emissions
purposes, calculations are based upon the amount of fuel burned, as well as the Height,
Temperature, Diameter, and Gas Velocity of each fire. For dispersion analyses, training fire
emissions are treated as point sources by EDMS. Training fire emissions are located spatially
within the airport using the (X, y) coordinates.

4.2.10 Buildings

Airport building sources affect the emitted point source plumes by essentially serving as obstacles
to those sources, and therefore have a significant impact on concentrations resulting from
stationary source emissions. Buildings have no effect on the concentrations estimated from
volume and area sources.

4.3 Dispersion Data Output

Modeling concentrations is a three-step process in EDMS. First, the user must select the
meteorological data to be used via the AERMET Wizard, which is started from the Weather
dialog, which is opened from the Airport menu heading. EDMS includes the optional use of
AERMAP, which is the terrain preprocessor of AERMOD. AERMAP creates source (.SRC) and
receptor (.REC) files for inclusion in AERMOD dispersion analyses. Next, the user must
Generate AERMOD Input Files, under the Dispersion menu heading. This step pre-processes the
emissions for every source for every hour in the weather data. The user also has the opportunity
to select different averaging periods as well as the desired pollutant at this time. Finally, the
dispersion calculations may be run by selecting Run AERMOD under the Dispersion menu
heading. To run AERMOD with the input files generated by EDMS on a different computer, the
user can refer to the instructions in the EDMS Technical Manual. Step-by-step instructions for
generating the AERMOD input files are provided in (Section 6.5.3).

As the dispersion algorithms execute, AERMOD displays its current status on the screen. Once
AERMOD has finished, the AERMOD window will close and the user will be returned to EDMS.
After AERMOD has run, EDMS will have created a directory for each scenario within the study
directory. In each scenario directory there will be a directory for each airport. In each airport
directory will be a file with the ((OUT) extension for each year and pollutant in the scenario-
airport combination. These files contain both the list of inputs to AERMOD along with the
concentrations for that scenario-airport-year-pollutant combination. These results can be viewed
and printed in any text editor, but TextPad is recommended. Concentration (.CON) files can be
viewed in the Concentrations View. Instructions for using the view concentrations option are
provided in (Section 6.6.4).






5 UTILITIES

The EDMS Utilities allow the user to define study elements that can then be used within EDMS
studies. User-Created objects can have customizable emissions factors, certain customizable
properties pertinent to the type of object, and default operating data, which can then be used in a
study in lieu of the system study objects that are provided with EDMS. The study elements that
can be created are Operational Profiles, User-created Aircraft, User-created GSE and User-
created APUs.

5.1 Operational Profiles

Operational profiles are used to vary the operational usage of an emissions source according to
the month of the year, day of the week, and quarter hour of the day. The profiles are used to more
accurately gauge the emissions rates, and thus to more accurately mode